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About this Guide

Welcome to the webMethods JI Installation and Configuration Guide. This guide 
provides procedures and reference information for installing webMethods JI. 

Before You Begin

This guide is intended for system administrators who are installing 
webMethods JI. Knowledge of UNIX and/or Microsoft® Windows™ system 
administration is required.

This guide provides information for the following procedures:

• Installing the webMethods JI server environment in UNIX and Windows 
environments.

• Installing the webMethods JI client libraries and interfaces in UNIX and 
Windows environments.

• Configuring the webMethods JI server environment and client components.

How This Book is Organized

This guide is organized as follows:

• Chapter 1 - "webMethods JI Installation" on page 9
• Chapter 2 - "Configuring the Environment" on page 55
• Chapter 3 - "Installing and Configuring webMethods JI Clients" on page 73
• Chapter 4 - "Creating Databases" on page 75
• Chapter 5 - "Uninstalling webMethods JI Software" on page 79
• “Glossary” on page 81
• “Index” on page 1
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Formatting Conventions

The following formatting conventions are used in this manual:

Documentation Set

webMethods JI is supplied with the manuals shown below. The documentation 
is delivered in Adobe Acrobat Reader Portable Document Format (PDF). No 
hardcopy documentation is provided, but you can print the PDF files on your 
local printer. 

Use this guide in conjunction with other manuals provided with webMethods JI:

Table 1.  Formatting conventions

Convention Used for..

Italics Italics are used for files, directories, programs, and 
book titles. For example: <JI_install_dir>/bin/
ea_mapmaker.exe. 

Monotype font A monotype font is used to represent examples of 
code, characters that the user enters, and prompts 
or messages from the system.  For example:  Type 
ea_start at the command prompt.

Sans-serif font A sans-serif font is used to represent Graphical 
User Interface (GUI) features, such as buttons. For 
example: Press the Help button to display a list of 
help topics.

Serif bold font This font is used for notes and warnings that require 
special attention. For example: Warning: You must 
install webMethods JI in an empty directory.
6 webMethods JI Installation and Configuration Guide Version 4.5
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Table 2.  webMethods JI documentation set

Title Description

webMethods JI Release Notes Provides information about additions and 
revisions to the current release of 
webMethods JI. The release notes are 
distributed in two forms, as a PDF and as a 
text file

webMethods JI Installation 
and Configuration Guide

Details installation procedures for 
webMethods JI.

webMethods JI Tutorial Provides hands-on instruction about how to 
write webMethods JI services using 
MapMaker

webMethods JI User’s Guide Describes how to configure the 
webMethods JI environment, as well as how 
to use webMethods JI graphical development 
and system monitoring tools.

webMethods JI Client 
Developer’s Guide

Describes how to design and develop 
webMethods JI client applications, as well as 
how to integrate webMethods JI services into 
third-party development environments.

webMethods JI Integration 
Guide

Contains information about integrating 
webMethods JI Services with other 
technologies, such as Siebel eBusiness 
Applications, MQSeries, Web Services, and 
more. 

webMethods JI Supplemental 
Reference Guide

Contains additional information on 
webMethods JI commands, error codes, 
language translation, keyboard mapping, 
logging, licensing, file formats, and field 
attributes. This guide replaces the 
Appendices that were duplicated across the 
manual set.
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 About this Guide

 

Viewing the Documentation Online

Online documentation is available in the following locations:

• In webMethods JI Graphical User Interfaces (GUIs), click on the Help menu 
and select Help Topics to display the webMethods JI documentation.

• webMethods JI documentation is available on-line in Adobe® Acrobat™’s 
Portable Document Format (PDF). If the documentation has been installed, 
open the file <JI_install_dir>/doc/_ji_doc.pdf in Adobe Acrobat Reader™ or a 
Web browser (where <JI_install_dir> is the location of your webMethods JI 
installation).

You can also access the latest version of the documentation for Software AG 
products at http://documentation.softwareag.com/. As new versions become 
available, the documentation on this web site will be updated and the previous 
versions will be migrated to the Empower Product Support Web site at https://
empower.softwareag.com/. If you have a maintenance contract, you can view all 
versions of documentation on this web site. You will find instructions for 
registering and obtaining a userid and password on the documentation web site.
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Chapter 1.  webMethods JI Installation

The webMethods JI installataion program (setup.bin for UNIX or setup.exe for 
Windows) is platform specific and contains all necessary files to install 
webMethods JI on a specfic target platform, as well as files to install 
webMethods JI client components in the Windows environment. This chapter 
outlines procedures for installing the server and client components in UNIX and 
Windows environments.

This chapter describes the following procedures for installing and configuring 
the webMethods JI environment on UNIX and Windows platforms:

• “Supported Operating Systems” on page 9
•   “Minimum System Recommendations” on page 9
•   “Disk Space Requirements” on page 10
•   “System Information” on page 11

• “Software Requirements” on page 11
•   “Java Software Requirements” on page 11
•   “Communication Protocol Support” on page 15

• “Installing webMethods JI Server Software” on page 15
• “Installing webMethods JI Server Software as a Windows Service” on page 49
• “Installing the webMethods JI Service” on page 50
• “Uninstalling the webMethods JI Service” on page 51
• “Installing Multiple webMethods JI Services” on page 51
• “Upgrading From an Earlier Release of webMethods JI” on page 52

•   “webMethods JI Upgrade Procedure” on page 52
•   “Converting a Database From MySQL to H2” on page 53

Supported Operating Systems

The list of supported hardware platforms and operating systems for this release 
of webMethods JI can be found in the”Supported Platforms” section in the 
current version of the webMethods JI Release Notes.

Minimum System Recommendations

Any system that meets the requirements of a supported operating system for that 
hardware platform may be used to run webMethods JI.
webMethods JI Installation and Configuration Guide Version 4.5 9
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Disk Space Requirements

The following table lists disk space requirements for a typical installation based 
on the operating system:

Please verify that there is enough disk space on your selected drive prior to 
installing the product.

Temporary Directory for Installation

The webMethods JI installation program temporarily extracts data into a 
temporary directory. Approximately twice the disk space listed above must be 
available in the temporary directory. These files are removed from the temporary 
directory after installation is successfully completed.

UNIX
In UNIX, the installation program checks to see if enough space is available in the 
/tmp directory. If there is not enough space, an error message is printed to the 
screen instructing the user to clear space in the /tmp directory.

Windows
In Windows, the installation program extracts the file to the directory identified 
in the %TMP% environment variable. If there is not enough disk space on the 
temporary directory’s disk partition to extract the data, the user is prompted to 
select another drive and directory for temporary extraction.

Operating System MegaBytes Required

Windows 200 MB

Oracle Solaris 200 MB

HP HP-UX 200 MB

IBM AIX 200 MB

Linux 200 MB
10 webMethods JI Installation and Configuration Guide Version 4.5
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System Information

TCP Ports

webMethods JI requires three TCP ports for webMethods JI service components. 
Default port numbers are provided during installation, but these defaults may 
need to be modified to ensure that they are set to available ports on your server. 
These ports can also be given symbolic names in your services file (or NIS/YP, if 
appropriate), which serves to “allocate” these port numbers as far as the server is 
concerned. However, webMethods JI programs cannot use the symbolic names 
directly; port numbers must be used.

The following table lists the default port numbers allocated during installation 
for each service component:

Software Requirements

The following software is required to use webMethods JI.

Java Software Requirements

The list of supported Java development kits for this release of webMethods JI can 
be found in the current version of the webMethods JI Release Notes.

To use the MapMaker graphical development environment’s code generation 
capabilities, the Tomcat Server or the ea_admin plist command, the Java 
Development Kit (JDK) is required, and should be pre-installed before installing 
webMethods JI.

Service Component Default Port at Installation

Resource Database 30000

Environment Manager system port 30001

RMI port 30002

Tomcat Server (optional) 8080
webMethods JI Installation and Configuration Guide Version 4.5 11
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Java Policy File

In order to use the webMethods JI server environment, a grant of “all 
permissions” must be included in your webMethods JI Java policy 
implementation. A default Java policy is included with every webMethods JI 
installation program. The webMethods JI installation program will automatically 
configure all webMethods JI programs to use the included Java policy file, which 
is located in <JI_install_dir>/etc. After installation, no further policy file 
configuration is required. 

To further customize your Java policy file configuration, see the information in 
the next section.

Customizing your Java Policy Implementation
The Java policy file can be customized, if desired, by using the following steps:

• Customize your policy file using Oracle's security guide (see 
http://docs.oracle.com/javase/8/docs/technotes/guides/security/
policyfiles.html).

• For all webMethods JI configuration files (for example, the Environment 
Manager configuration file) that contain the java VM command line, the 
following default options can be edited as required:
-Djava.security.manager -Djava.security.policy=<policy_file>

For example, the following could be entered for the javacmd parameter in 
your Environment Manager’s configuration file:
javacmd=java -Djava.security.manager -Djava.security.policy=
my_java.policy com.jacada.ea.envmanager.app.EAServer

• For all LAX files that contain the java VM command line, edit the following 
default options:
java.security.manager=null

java.security.policy=<policy_file>

Example:
java.security.manager=null

java.security.policy=etc/.java.policy

For more information about editing LAX files, see the webMethods JI User’s 
Guide.

Note: Due to the nature of Java technology where objects are exchanged 
across a network, it is recommended that all webMethods JI Java-based 
programs, regardless of platform, be run using the same version of the Java 
Virtual Machine, in order to avoid any JVM version incompatibilities.
12 webMethods JI Installation and Configuration Guide Version 4.5
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EA_ENV Environment Variable

In order to use the ea_start and ea_shutdown command, along with other 
administrative commands, the EA_ENV environment variable should be set to 
the <JI_install_dir>/config> directory. If this environment variable is not set, 
ea_start and ea_shutdown must be started using the following command line 
option:
-c <configuration directory>.

Also, the EA_ENV environment variable can be used by certain webMethods JI 
clients.

The environment.ccf File

The environment.ccf file must be located in the directory referenced by the 
EA_ENV environment variable, and must contain settings for the EA_HOME, 
EA_ENVMGR and DB_TCP_PORT properties:

• EA_HOME: The installation directory of your webMethods JI installation (i.e., 
<JI_install_dir>).

• EA_ENVMGR: The port number of the Environment Manager, used to 
determine if the Environment Manager is running.

• DB_TCP_PORT: The TCP port number of your resource database server.
• START_TOMCAT: Controls whether the embedded Tomcat servlet engine is 

started and stopped, by default, with the ea_start and ea_shutdown 
commands. The default setting is true.

Also, the EA_HOME, EA_ENVMGR, andDB_TCP_PORT properties can be 
defined as environment variables if the environment.ccf file is not used. The 
property settings in the environment.ccf will override the environment variables if 
both are set.

DISPLAY Environment Variable

In UNIX, when using webMethods JI graphical interfaces or opening a terminal 
window, the DISPLAY environment variable must be set to the appropriate IP 
address or host name of the machine on which your X-server software is running. 
This variable is set using the format <host>:0.0 where <host> is the name or IP 
address of the host machine. For example:
export DISPLAY=127.0.0.1:0.0
webMethods JI Installation and Configuration Guide Version 4.5 13
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TERMINFO Environment Variable

On HP-UX, the TERMINFO variable must be set for proper function key behavior 
within PATerm terminal windows. Set the TERMINFO environment variable to 
<JI_install_dir>/lib/terminfo directory.

webMethods JI Licenses

One or more webMethods JI licenses are required to use the webMethods JI 
environment. A licensing mechanism is included with webMethods JI that 
controls the following aspects of the webMethods JI environment:

• The capability of the MapMaker development tool to modify and generate 
webMethods JI Services.

• The number of concurrent servers (host machines) that are running 
webMethods JI Environment Managers. This limit is not tied to a specific 
server machine, which allows for flexibility in Environment Manager 
deployment. As long as the total number of Environment Managers in the 
user’s environment does not exceed the license limit, the Environment 
Managers can be running on any server in the network.

• The number of concurrent webMethods JI Services running on each server 
(optional license mechanisms are available for customer requirement 
flexibility).

For more information, see the webMethods JI User’s Guide.

X11-Compatible Window Server

UNIX only: In order to be able to run the webMethods JI graphical installer or to 
use PATerms and JTerms, an X11-compatible window server is required.

JDBC Driver Included in Installation

A JDBC driver, tjFM, is included with installation of webMethods JI and is 
required to access previous versions of the Resource Database. The tjFM driver 
cannot be removed from webMethods JI and may not be used outside of 
webMethods JI except by acquiescence to tjFM's terms of agreement.

Note: The licenses provided with webMethods JI 3.5 do not work with the 
4.5 release. Consult webMethods JI Technical Support to obtain proper 4.5 
licenses. 
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Communication Protocol Support

webMethods JI supports TCP/IP communication protocols for client connections 
and the following communication protocols for mainframe connections:

• TN3270/TN3270E Models 2-5: Models 3, 4, and 5 are supported with Java 
services only.

• TN5250 Standard (80 column and 132 column): The session capability of 
TN5250E is also supported, although no other aspects of TN5250E are 
implemented.

• Telnet (VT100, VT220, VT320 and ANSI emulation): Telnet is used for 
Character Mode and referred to as such throughout this manual.

See the webMethods JI Supplemental Reference Guide, Chapter 3: Keyboard 
Mapping, for keyboard mapping information. Protocol agent configuration 
information is located in the <JI_install_dir>/lib/ProtoAgents directory, where 
<JI_install_dir> represents the directory in which webMethods JI has been 
installed.

Installing webMethods JI Server Software

The webMethods JI installation program is a Java application which can be run 
on Windows or UNIX operating systems. A platform-specific version of the 
installation program is provided for each of the supported operating systems. By 
default, the installation program will run with a graphical user interface but may 
also be run with a console user interface. Console mode allows installation on 
systems which do not have a graphical user interface, for example, “headless” 
UNIX servers. Both methods will be described below.

GUI Mode Installation

The following steps outline how to use the webMethods JI GUI installation 
program.

Note: Before starting any webMethods JI installation, please shut down any 
existing installations that may be using the same TCP port numbers.
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Step 1: Launch the GUI Installation

Windows
The following description assumes you have copied the approrpiate 
webMethods JI installer to a directory on the machine you wish to install it on.

To launch the installation program in Windows, select Run from the Start Menu. 
Type <path_to_installer>\setup.exe, where <path_to_installer> 
represents the directory path the webMethods JI installer was copied to. Press 
Enter or click on the OK button to launch the installation program. Alternatively 
you may browse to the directory containing the JI installer using the Windows 
Explorer and double-click on setup.exe.

UNIX
The following description assumes you have copied the approrpiate 
webMethods JI installer to a directory on the machine you wish to install it on.

1 Change directory to the directorycontinaining the webMethods JI installer:
cd <path_to_installer>

2 Type ./setup.bin or <path_to_installer>/setup.bin at the UNIX 
prompt. This will start the webMethods JI installation utility.

3 Observe the installer extracts a series of files.

Step 2: Introduction to webMethods JI Installation

The first window displayed during the execution of the installation program 
provides a visual indication of the loading of the installer. The next screen to 
appear is the Introduction to the webMethods JI installation program with an 
explanation of its navigational features (Figure 1).

Note: When running on UNIX and the InstallAnywhere installer exits 
silently, check your ENV environment variable and your .kshrc file. If your 
ENV environment variable points at your .kshrc file and your .kshrc file 
modifies your CLASSPATH environment variable, the installer exits 
silently with no error. The workaround is to not set CLASSPATH in your 
.kshrc file.
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Figure 1.  webMethods JI Installation Program Introduction

Click the Next button to proceed.

Step 3: The License Agreement

The next window displays the webMethods JI licence agreement (Figure 2).
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Figure 2.  The webMethods JI Licence Agreement

To accept the license, select the I accept the terms... radio button and click the Next 
button to proceed with installation.

Next, a Readme file is displayed in the installation program’s Important 
Information window. Click on the Next button to proceed.

Step 4: Select Install Folder

The next window is used to select the directory in which webMethods JI will be 
installed (Figure 3). 
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Figure 3.  Select an installation directory

The default location for Windows is C:\JI. For UNIX, the default location is 
<home>/JI, where <home> is the installing user’s home directory. A new 
directory will be created if it does not already exist. To change the default 
installation directory, select the Choose... button. Select the directory from the 
window provided.

Directory Names that Contain Spaces
It is recommended that you do not install JI into the C:\Program Files on Windows 
directory or any directory tree that has spaces in the names of the directories. This 
restriction applies to both Windows and UNIX installations.

Note: Installing webMethods JI over an older release is not 
supported. Installing webMethods JI over a previous installation 
of the same version, using the same directory, will result in files 
being overwritten. Should you wish to retain configuration file 
settings, back up the necessary configuration file settings and 
restore them upon completion of the installation.
You must have read/write privileges for the installation directory. 
webMethods JI should be installed into an empty directory.
webMethods JI Installation and Configuration Guide Version 4.5 19



Chapter 1. webMethods JI Installation

 

Step 5: Select the Location for the Shortcuts (Windows Only)

The next window is available for Windows installation only. This window allows 
you to select the location of your webMethods JI shortcuts (Figure 4).

Figure 4.  Define application shortcuts

Select the appropriate option and click the Next button.

Step 6: Select a Java Virtual Machine

Because a Java Virtual Machine (JVM) is required to run the webMethods JI 
server environment, you must select a JVM that is already installed on your file 
system.

Note: To use the service generation features of the MapMaker graphical 
development environment, a Java Developers Kit (JDK), is required. The JDK 
is not provided with this installation.
20 webMethods JI Installation and Configuration Guide Version 4.5



Chapter 1. webMethods JI Installation

 

This window describes the JDK requirement for running the Tomcat application 
server (Figure 5).

Figure 5.  JVM Selection

After selecting a JVM during installation, the installation program updates files 
with the location of the JVM. As a result, if you choose at a later date to use a 
newer JVM or a different JVM from the one selected during installation, you will 
have to edit these files to change the location of the JVM. This affects the 
following areas in the installation:

• The Environment Manager configuration file. For more information about 
editing the Environment Manager configuration file, see the webMethods JI 
User’s Guide.

• Lax files. Lax files are created by the installation program for use by 
webMethods JI commands. The lax files provide information to the 
commands, such as the location of the JVM used to launch the commands. 
For information about changing the JVM referenced in webMethods JI lax 
files, see the webMethods JI User’s Guide.

This window allows you to select a JVM (Figure 6).
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Figure 6.  Select a Java VM for the application

To select a JVM, click the preferred JVM from the list. If the JVM you wish to select 
is not listed in the window, you can instruct the installation program to search for 
JVMs again or you can select the JVM manually by clicking the Choose Another... 
button and locating the JVM on your file system. The path specified for the JVM 
must be a full path to a JDK or JRE installation. Symbolic links are not supported 
in this path.

Step 7: Select the Database Settings

During installation of the server environment, the installation program will 
create a Resource Database, if one is desired. Should a Resource Database already 
exist, you may elect to use it instead of creating a new one. In that case, uncheck 
the Create database checkbox and continue to the next screen. If a new Resource 
Database is to be created, enter a unique port number and a name for the database 
(Figure 7).
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Figure 7.  Identify or Create a resource database

To use an existing database, enter the appropriate port number for the database 
daemon and the database name, uncheck the Create database checkbox, then 
click the Next button. This will identify to the Configuration Manager the 
database to be used.

To create a new database, enter the appropriate port number for the database 
daemon and a name for the database, check the Create database checkbox, then 
click the Next button.

Step 8: Set the Tomcat HTTP Port Number

Next, define the Apache Tomcat HTTP port number. To do this, enter the port 
number for the Tomcat web server and click the Next button.

Note: If you later change the database name, you will have to edit the 
resource database location in the Configuration Manager prior to launching 
the Environment Manager, for more information, see Step 4: Editing the 
Database Daemon Location and RDB Name on page 18.
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Step 9: Enter the License Keys

Enter the License Key name and license key(s) that were provided to you by 
Software AG. Multiple License Names and Keys may be entered at this screen. 
After entering the License Name and the License Key(s), click the Add button and 
observe that the License Key information appears in the License Keys display 
window, and the message "License Key validated and added" is 
displayed. Add additional license keys as required. When all license keys have 
been entered, click Next to continue the installation (Figure 8).

Figure 8.  Installer- Enter License Keys Information

If license keys are not available at the time of the installation, you may skip this 
step by clicking Next. The license(s) may be entered later via the Configuration 
Manager.

If an invalid license key is entered, a message prompting you to enter a valid 
license key will be displayed in this panel.

Step 10: Select the Installation Set

The next window in the installation program allows you to select the files that 
should be installed. The following installation set options are offered (Figure 9): 

• Full Server
• Full Client
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• Custom

Figure 9.  Select the installation set 

Installation Set Description

Full Server The following items are installed by default when the 
Full Server installation is selected:

• All components of the webMethods JI server 
environment.

• All webMethods JI Graphical User Interfaces 
(GUIs).

• All webMethods JI client libraries and interfaces.
• All webMethods JI documentation, in PDF format.

Note: The GUIs are not installed on UNIX.
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The components included with each installation set can be customized. For 
information about customizing the installation, see Step 11: Customizing the 
Installation Set, below. To install the default components without customizing the 
installation, select the appropriate installation set.

If the Full Server option was selected, observe that webMethods JI is installed on 
your system.

Step 11: Customizing the Installation Set

To customize the components that will be installed, select Custom and then click 
the Next button. The Choose Product Components dialog window will open 
(Figure 10):

Full Client The following items are installed by default when the 
Full Client installation is selected:

• All webMethods JI Graphical User Interfaces 
(GUIs).

• All webMethods JI client libraries and interfaces.
• All webMethods JI documentation, in PDF format.

Custom This option represents the same installation as the 
typical server, except that each element is selectable to 
be included or excluded from the installation.

Installation Set Description

Note: The GUIs are not installed on UNIX.
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Figure 10.  Customizing the installation set

To select or deselect items for installation, click on the check box next to the item. 
The following options are available for customized installation:  

Option Description

Server 
Components

Installs all components necessary to run the 
webMethods JI server environment. Included are the 
Environment Manager, Resource Server, Resource 
Database, configuration files, and all supported 
classes and other files required to run the 
environment.
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After selecting the components for installation, click the Next button to display 
the Pre- Installation Summary.

Step 12: Pre-Installation Summary

The Pre-Installation Summary is a check screen to allow the user to review the 
installation choices made up to this point. If an error is discovered at this point 
(e.g., incorrect JVM selected), the user may return to the appropriate screen, using 
the Previous button to navigate back, and correct the errant entry. When all 
parameters have been entered satisfactorily, then click the Install button to 
proceed with the installation (Figure 11).

Client Software Installs the client libraries and interfaces included 
with webMethods JI. You can select individual client 
components for installation. Available components 
are:

• Libraries: Installs the selected webMethods JI 
client libraries.

• Gateways: Installs the webMethods JI HTTP 
Gateway or the MQ Gateway.

• Siebel Integration Examples: Installs example files 
for integrating webMethods JI with Siebel 
applications. For more information about 
integrating webMethods JI and Siebel, see the 
webMethods JI Client Developer’s Guide.

MapMaker Installs the webMethods JI MapMaker graphical 
development environment.

Configuration 
Manager

Installs the webMethods JI Configuration Manager, a 
graphical user interface (GUI) application used to 
configure webMethods JI environments.

System Monitor Installs the webMethods JI System Monitor, a GUI 
application used to monitor webMethods JI 
environments.

Documentation Installs the complete set of webMethods JI 
documentation in PDF format.

Option Description
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Figure 11.  Pre-Installation Summary 

The Installing window is displayed as the files are being installed on your system 
(Figure 12):

Note: In some cases, the JI installer may calculate the amount of free disk 
space incorrectly, requiring you to free disk space or quit the installation even 
though there is more than enough disk space available to install JI. To work 
around this problem, the environment variable “CHECK_DISK_SPACE” 
may be set to “OFF” prior to running the installer:

CHECK_DISK_SPACE=OFF
export CHECK_DISK_SPACE
setup.bin
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Figure 12.  Installing

Observe the webMethods JI installation continues until finished and the Install 
Complete window is displayed. Click Done to close the window (Figure 13).
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Figure 13.  Install Complete

Console Mode Installation

The following steps outline how to run the webMethods JI installation in console 
mode.

Step 1: Launch the Console Installation

Windows
Copy the approrpiate webMethods JI installer to a directory on the machine you 
wish to install it on.

To launch the installation program in Windows, select Run from the Start Menu. 
Type <path_to_installer>\setup.exe -i console, where 
<path_to_installer> represents the directory path the webMethods JI 
installer was copied to. Press Enter or click on the OK button to launch the 
installation program in console mode.
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UNIX
Copy the approrpiate webMethods JI installer to a directory on the machine you 
wish to install it on.

1 Change directory to the directorycontinaining the webMethods JI installer:
cd <path_to_installer>

2 Type ./setup.bin -i console or <path_to_installer>/
setup.bin -i console at the UNIX prompt. This will start the webMethods JI 
installation utility in console mode.

3 Observe the installer extracts files, configures and proceeds to the first screen 
of the installation.

Note: When running on UNIX and the InstallAnywhere installer exits 
silently, check your ENV environment variable and your .kshrc file. If your 
ENV environment variable points at your .kshrc file and your .kshrc file 
modifies your CLASSPATH environment variable, the installer exits 
silently with no error. The workaround is to not set CLASSPATH in your 
.kshrc file.
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Step 2: Introduction to webMethods JI Installation

The first screen displayed during the execution of the console installation 
program provides a visual indication of the loading of the installer the 
Introduction to the webMethods JI installation program (Figure 14).

Figure 14.  webMethods JI Console Installation Program Introduction

Press Enter to continue to the next screen.
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Step 3: The License Agreement

The next screen displays the first page of the license agreement (Figure 15).

Figure 15.  The webMethods JI License Agreement
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Press Enter to continue through to the last page of the license agreement where 
you will be prompted to accept the terms of the license agreement (Figure 16).

Figure 16.  Accepting the webMethods JI License Agreement

To accept the license agreement and continue to the next screen, press Y and 
Enter.
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Step 4: Select Install Folder

The next screen is used to select the directory in which webMethods JI will be 
installed (Figure 17).

Figure 17.  Select an installation directory

Press Enter to accept the default installation directory or type in the path of the 
directory you would like to use for the webMethods JI installation and press 
Enter. You will then be asked to confirm your installation directory selection. 
Type Y and press Enter to confirm the installation directory and continue to the 
next screen or type N and press Enter to re-enter the installation directory.
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Step 5: Select the Location for Windows Shortcuts

The next screen is displayed for Windows only and allows you to select the 
location of the Windows shortcuts for webMethods JI (Figure 18).

Figure 18.  Choose Link Location

Select the approprate option and press Enter to continue.

Step 6: Select a Java Virtual Machine

Because a Java Virtual Machine (JVM) is required to run the webMethods JI 
server environment, you must select a JVM that is already installed on your file 
system.

Note: To use the service generation features of the MapMaker graphical 
development environment, a Java Developers Kit (JDK), is required. The JDK 
is not provided with this installation.
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This screen describes the JDK requirement for running the Tomcat aplication 
server (Figure 19).

Figure 19.  JVM Selection

After selecting a JVM during installation, the installation program updates files 
with the location of the JVM. As a result, if you choose at a later date to use a 
newer JVM or a different JVM from the one selected during installation, you will 
have to edit these files to change the location of the JVM. This affects the 
following areas in the installation:

• The Environment Manager configuration file. For more information about 
editing the Environment Manager configuration file, see the webMethods JI 
User’s Guide.

• Lax files. Lax files are created by the installation program for use by 
webMethods JI commands. The lax files provide information to the 
commands, such as the location of the JVM used to launch the commands. 
For information about changing the JVM referenced in webMethods JI lax 
files, see the webMethods JI User’s Guide.
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This window allows you to select a JVM (Figure 20).

Figure 20.  Select a Java VM for the application

To select a JVM, enter the number of the preferred JVM from the list or the 
number of the last entry in the list to enter the path of a JVM which is not 
presented in the list. The path selected must be an absolute path to a JDK or JRE 
installation. Symbolic links are not supported in this path.
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Step 7: Select the Database Settings

The next screen allows you to configure the webMethods JI Resource Database 
settings and whether or not to create a new Resource Database at install time 
(Figure 21).

Figure 21.  Identify or create a Resource Database

To use an existing database, enter the port number for the Resource Database 
server and the database name and type N and press Enter at the Create database 
prompt

To create a new database, enter the port number for the Resource Database server 
and the database name and type Y and press Enter at the Create database prompt.

Note: You must select a JVM that is compatible with Oracle’s JDK 1.4.2_05 or 
newer. Multiple JVMs may be listed in this dialog box; not all of them are 
necessarily 1.4.2_05 compatible. For example, Microsoft JVMs may be listed 
in this dialog box. Make sure you select a 1.4.2_05 or newer compatible JVM.

Note: If you later change the database name, you will have to edit the 
resource database location in the Configuration Manager prior to launching 
the Environment Manager, for more information, see Step 4: Editing the 
Database Daemon Location and RDB Name on page 18.
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Step 8: Set the Tomcat HTTP Port Number

The next screen allows you to define the Tomcat application server port number 
(Figure 22)

Figure 22.  Enter a Tomcat port number

Enter the port number for the Tomcat application server or press Enter to accept 
the default port number.

Step 9: Enter the License Keys

Enter the License Key name and license key(s) that were provided to you by 
Software AG. Multiple License Names and Keys may be entered at this screen. 
After entering the License Name and the License Key(s), click the Add button and 
observe that the License Key information appears in the License Keys display 
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window, and the message "License Key validated and added" is 
displayed. Add additional license keys as required. When all license keys have 
been entered, click Next to continue the installation (Figure 23).

Figure 23.  Enter webMethods JI license information

If license keys are not available at the time of the installation, you may skip this 
step by pressing Enter at the License Key and Name prompts and typing Y and 
pressing Enter at the IS THIS CORRECT prompt. The license(s) may be entered 
later via the Configuration Manager.

If an invalid license key is entered, a message prompting you to enter a valid 
license key will be displayed and the License Keys screen will be displayed again.
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Step 10: Select the Installation Set

The next screen allows you to select the installation set or customize your 
webMethods JI installation. (Figure 24)

Figure 24.  Select the installation set

Installation Set Description

Full Server The following items are installed by default when the 
Full Server installation is selected:

• All components of the webMethods JI server 
environment.

• All webMethods JI Graphical User Interfaces 
(GUIs).

• All webMethods JI client libraries and interfaces.
• All webMethods JI documentation, in PDF format.

Note: The GUIs are not installed on UNIX.
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The components included with each installation set can be customized. For 
information about customizing the installation, see Step 11: Customizing the 
Installation Set, below. To install the Full Server or Full Client components without 
customizing the installation, type the appropriate number from the list and press 
Enter.

Full Client The following items are installed by default when the 
Full Client installation is selected:

• All webMethods JI Graphical User Interfaces 
(GUIs).

• All webMethods JI client libraries and interfaces.
• All webMethods JI documentation, in PDF format.

Custom This option represents the same installation as the 
typical server, except that each element is selectable to 
be included or excluded from the installation.

Installation Set Description

Note: The GUIs are not installed on UNIX.
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Step 11: Customizing the Installation Set

To customize the installation set type the appropriate number from the list and 
press Enter to continue to the ChooseProduct Features screen (Figure 25).

Figure 25.  Customizing the installation set
webMethods JI Installation and Configuration Guide Version 4.5 45



Chapter 1. webMethods JI Installation

 

To select or deselect items for installation, type a comma separated list of 
numbers representing the features you would like to select or deselect. Items with 
items with [X] next to them are selected for installation and items with [ ] next 
them are deselected. The following options are available for customized 
installation:  

Option Description

Server 
Components

Installs all components necessary to run the 
webMethods JI server environment. Included are the 
Environment Manager, Resource Server, Resource 
Database, configuration files, and all supported 
classes and other files required to run the 
environment.

Client Software Installs the client libraries and interfaces included 
with webMethods JI. You can select individual client 
components for installation. Available components 
are:

• Libraries: Installs the selected webMethods JI 
client libraries.

• Gateways: Installs the webMethods JI HTTP 
Gateway or the MQ Gateway.

• Siebel Integration Examples: Installs example files 
for integrating webMethods JI with Siebel 
applications. For more information about 
integrating webMethods JI and Siebel, see the 
webMethods JI Client Developer’s Guide.

MapMaker Installs the webMethods JI MapMaker graphical 
development environment.

Configuration 
Manager

Installs the webMethods JI Configuration Manager, a 
graphical user interface (GUI) application used to 
configure webMethods JI environments.

System Monitor Installs the webMethods JI System Monitor, a GUI 
application used to monitor webMethods JI 
environments.

Documentation Installs the complete set of webMethods JI 
documentation in PDF format.
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After entering the list of components to select and deselect for installation, press 
enter to continue to the Pre- Installation Summary screen.

Step 12: Pre-Installation Summary

The Pre-Installation Summary (Figure 26) is a check screen to allow the user to 
review the installation choices made up to this point. If an error is discovered 
(e.g., incorrect JVM selected), the user must interrupt the instalation and start 
over.
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Figure 26.  Installation Summary
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Press enter to start the installation. The installer will display a progress screen 
during the installation and the message Installation finished successfully will be 
displayed when the installation is complete (Figure 27).

Figure 27.  Installation complete

Installing webMethods JI Server Software as a Windows 
Service

When webMethods JI is installed on a Windows server as a standard application, 
it cannot run unless a user is logged on to the Windows server. To provide 
continued, unattended access to webMethods JI, you can install it as a service 
within the Windows registry. 

Note: In some cases, the JI installer may calculate the amount of free disk 
space incorrectly, requiring you to free disk space or quit the installation even 
though there is more than enough disk space available to install JI. To work 
around this problem, the environment variable “CHECK_DISK_SPACE” 
may be set to “OFF” prior to running the installer:

CHECK_DISK_SPACE=OFF
export CHECK_DISK_SPACE
setup.bin
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As a Windows service, webMethods JI can be conveniently controlled through 
the Windows Services applet, which is accessed through the Control Panel 
(Figure 28).

Figure 28.  The webMethods JI Service in the Windows Services Applet

Installing the webMethods JI Service

The webMethods JI Server is installed (or removed) as a Windows service using 
the ji_svc program. Given a webMethods JI 4.5 installation in the C:\JI 
directory, the following command will perform the installation:

ji_svc -i -w C:\JI

The following table lists the default webMethods JI Service properties, as well as 
the commands used to modify these properties.

Note: webMethods JI Windows Service functionality is only supported on 
Microsoft's server operating systems.

Property Default Value Modified Via...

Service Name JIService -s <Service Name>

Display Name webMethods JI 
Server

-d <Display Name>
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For a detailed description of the ji_svc program, see the webMethods JI 
Supplemental Reference Guide.

Uninstalling the webMethods JI Service

The following command removes the previously installed webMethods JI 4.5 
Windows Service:

ji_svc -r -s JIService

Installing Multiple webMethods JI Services

Each webMethods JI Service is an instance of the webMethods JI Server, which 
has been installed as a Windows Service. There may be zero or more 
webMethods JI Services on any Windows system. 

If there is more than one webMethods JI Service on a particular system, each 
instance must have a unique Service name. In addition, each Service instance 
should have a unique Display name, so that you can differentiate between these 
instances in the Services applet (see Figure 28).

Working 
Directory

C:\JI -w <Working Directory>

Note: When removing a webMethods JI Service, the Service name must be 
the same as the one used when the webMethods JI Service was installed.

Note: It is recommended that each webMethods JI Service instance has its 
own webMethods JI installation directory.

Property Default Value Modified Via...
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Upgrading From an Earlier Release of webMethods JI

For the purposes of this discussion, the currently installed environment will be 
referred to as the source environment and the upgraded environment will be 
referred to as the target environment. In addition, the example commands given 
below will assume the default values for database name, ports, etc. See the 
manual pages for the individual commands in the webMethods JI Supplemental 
Reference Guide for the command line options required for setting non-default 
values. The "webMethods JI Upgrade Procedure" below should used when 
upgrading from webMethods JI 4.5.6 and newer versions. "Converting a 
Database From MySQL to H2" describes the process to be used when upgrading 
from JI 4.5.5 and earlier to JI 4.5.6 and newer versions.

webMethods JI Upgrade Procedure

The following steps describe the procedure for upgrading from a previous 
release of webMethods JI when the source and target environments are both 
running the same database server software (MySQL or H2).

1 Start the source environment Resource Database
<src_env_dir>/bin/ea_start -m

Where <src_env_dir> is the path to the source JI environment installation 
directory.

2 Export the source Resource Database
<src_env_dir>/bin/ea_exportdb <exports_dir>/access.exp

Where <exports_dir> is the path to the directory containing the database 
export file.

3 Shut down the source Resource Database
<src_env_dir>/ea_shutdown -m

4 Install the target JI environment
See “Installing webMethods JI Server Software” on page 15 for detailed 
instructions on installing JI.

5 Copy the maps from the source environment to the target environment
6 Start the target Resource Database and Resource Server

<trgt_env_dir>/bin/ea_start -D -r

Where <trgt_env_dir> is the path to the target JI environment installation 
directory.

Note: You may need to reboot the machine or reset the EA_ENV and 
PATH environment variables after installing the target JI environment.
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7 Import the source database export file created in step 2 above into the target 
database
<trgt_env_dir>/bin/ea_importdb <exports_dir>/access.exp

8 Regenerate and redeploy your JI services
For each map:
a Load the map into MapMaker
b Update the map
c Generate the map
d Deploy the generated service(s) and/or web service(s)

9 Test the deployed services

Converting a Database From MySQL to H2

When upgrading from a webMethods JI 4.5.5 or earlier environment to a JI 4.5.6 
or newer environment, the upgrade procedure must be modified slightly. The 
MySQL source database must be converted to H2 import format using the 
ea_convertdb command from the target environment before it can be imported 
into the target H2 database. The following steps describe the procedure for 
converting a MySQL Resource Database to H2 import format.
1 Install the target JI environment

See “Installing webMethods JI Server Software” on page 15 for detailed 
instructions on installing webMethods JI.

2 Start the source environment Resource Database
<src_env_dir>/bin/ea_start -i <src_env_dir> -c <src_env_cfg_dir> -m

Where <src_env_dir> is the path to the source JI environment installation 
directory and <src_env_cfg_dir> is the path to the source JI environment 
config directory.

3 Convert the source database to H2 import format using the ea_convertdb 
command
<trgt_env_dir>/bin/ea_convertdb -H <src_db_host> -p <src_db_port> -n 
<src_db_name> access.exp

Where <trgt_env_dir> is the path to the target JI environment installation 
directory, <src_db_host> is the host name or address of the machine the 
source environment is running on, <src_db_port> is the source database 
TCP port and <src_db_name> is the name of the source database.

4 Shutdown the source Resource Database
<src_env_dir>/bin/ea_shutdown -c <src_env_cfg_dir> -i <src_env_dir> -m

5 Start the target Resource Database
<trgt_env_dir>/bin/ea_start -D

6 Import the converted source database export into the target database using 
the ea_importdb command
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<trgt_env_dir>/bin/ea_importdb access.exp

Where <exports_dir> is the path to the directory containing the database 
export files.

7 Start the target Resource Server
<trgt_env_dir>/bin/ea_start -r

8 Regenerate and redeploy your JI services as described in step 8 of the 
"webMethods JI Upgrade Procedure" above
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Preliminary Configuration Steps

This chapter discusses how to verify your installation and configure your 
webMethods JI server environment. 

The following steps are required:

Step 1: Starting the Resource Database and the Resource Server

Step 2: Starting the Configuration Manager

Step 3: Entering your License Key

Step 4: Editing the Database Daemon Location and RDB Name

Step 5: Starting the Environment Manager

Step 6: Connecting to the Environment Manager in the Configuration Manager

Step 7: Editing Environment Manager Configuration Parameters

Step 8: Changing the Resource Server’s RMI Port

Step 9: Changing the Resource Name for the Resource Database

Step 10: Editing the Environment Manager Configuration in the Resource Database

Step 11: Setting EA_ENV and Editing the environment.ccf File

Advanced Configuration

The steps in this chapter are for basic configuration tasks. Your configuration 
tasks may vary depending on the server components required. For more 
information about advanced configuration (i.e. load balancing, redundancy, 
proxy server configuration) of the webMethods JI server environment, see the 
webMethods JI User’s Guide.

Step 1: Starting the Resource Database and the Resource Server

The Resource Database is a process that runs in the webMethods JI server 
environment and is used to provide storage for various data components. The 
Resource Database is built upon the embedded third-party H2 database engine. 
For more information about the Resource Database and H2, see the webMethods JI 
User’s Guide.
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The Resource Database is started using the following command:

UNIX: 
cd <JI_install_dir>/bin

./ea_start -D

Windows: 
cd <JI_install_dir>\bin

.\ea_start -D

The Resource Database can also be launched using shortcuts in Windows, if 
shortcuts were created during installation. For example, if shortcuts were added 
to the Start Menu during installation, the Resource Database can be started by 
selecting the ResourceDatabase shortcut from the Start Menu. Configuration 
information for the Resource Database can be changed at a later time (see Step 4: 
Editing the Database Daemon Location and RDB Name).

The Resource Server is a process that runs in the webMethods JI server 
environment, and is used to provide access to various data sources within the 
webMethods JI environment, including the license file and the Resource 
Database. For more information about the Resource Server, see the webMethods JI 
User’s Guide. 

The Resource Server is started using the following command:

UNIX:
cd <JI_install_dir>/bin

./ea_start -r

Windows:
cd <JI_install_dir>\bin

.\ea_start -r

The Resource Server can also be launched using shortcuts in Windows, if 
shortcuts were created during installation. For example, if shortcuts were added 
to the Start Menu during installation, the Resource Server can be started by 
selecting the Resource Server shortcut from the appropriate program menu in the 
Start Menu.
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Step 2: Starting the Configuration Manager

cd <JI_install_dir>\bin.\ea_cfgmgr

The Configuration Manager can also be launched using shortcuts in Windows, if 
shortcuts were created during installation. For example, if shortcuts were added 
to the Start Menu during installation, the Configuration Manager can be started 
by selecting the Configuration Manager shortcut from the appropriate program 
menu in the Start Menu.

This will open the Configuration Manager graphical interface (Figure 29).

Figure 29.  The Configuration Manager GUI

Note: If the Resource Server does not start, it could be because of a port 
conflict. By default, the Resource Server tries to start using an RMI port of 
30002 (it can share this RMI port with the Environment Manager). In the 
event of a port conflict, change the Resource Server’s RMI port using the -p 
<rmiport> command line option when launching the Resource Server:

cd <JI_install_dir>/bin
./ea_start -r -p <rmiport>

Where <rmiport> represents a valid port number of the Resource Server’s 
RMI port (this port can be the same as the Environment Manager’s RMI port).

Instructions for permanently changing the Resource Server’s RMI port are 
found in Step 8: Changing the Resource Server’s RMI Port, on page 66.
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Step 3: Entering your License Key

If the license key information was not entered during the installation, follow 
these directions to enter your License Key in the Configuration Manager.

1 Under the Resource Server node, highlight your Resource Server (identified 
by the host name and port number of the Resource Server. See Figure 30).

Figure 30.  Select the resource server

2 Select File > Connect or click the Connect button  to connect to the 
Resource Server. The resources served by the Resource Server will be listed as 
subordinate to the Resource Server’s node in the Tree (Figure 31).

Figure 31.  Resources served by the Resource Server

3 Highlight the license node and select File > Open datasource or click the Open 
datasource button  to open the license file for editing.

4 Next, right-click on the license node and select New License Key Node from 
the pop-up menu (Figure 32). 

Resource 
Server

Resource 
Database

License 
Resource
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Figure 32.  The license node control menu

A dialog box opens, requiring the license key and name (Figure 33).

Figure 33.  Enter key and name information

5 Enter the 64 character License Key and the License name that have been 
provided to you by Software AG. 

Note: The license parameter in the envmgr.cfg file (located in the 
<JI_install_dir>/config directory) should match the license name entered here 
(the default name is SoftwareAG).
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Step 4: Editing the Database Daemon Location and RDB Name

Next, we will use the Configuration Manager to identify the host and port on 
which the resource database server is running, along with the name of the 
Resource Database. There are two reasons why you might need to change the 
database location and name:

• During installation, a Resource Database can be created. If a database is 
created, and the database port and/or name is changed from their default 
settings, the values entered during installation should be changed in this step.

• If a database is not created during installation, the database host:port and 
name of the Resource Database must be changed to that of the desired 
Resource Database.

Default Settings
By default, the Resource Database’s host is localhost, its port is 30000, and the 
default name of the database is access. If default settings for these items are 
used, they do not need to be changed and you can proceed to Step 5: Starting the 
Environment Manager.

Steps to Change the Database Location and Name
The Resource Database is identified in the Configuration Manager tree by its 
Resource name. The default Resource name after installation is ea. 

1 Highlight the Resource named ji, subordinate to the Resource Server node. 
The location and name of the Resource Database will be displayed as the 
value for the Data source address property in the Properties view (Figure 34).

Note: This step is required only if you wish to change the database location 
and RDB name after the installation.

Note: This default resource name will be modified in Step 9: Changing the 
Resource Name for the Resource Database.
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Figure 34.  Selecting the Resource Named ji

2 Edit the Data source address field in the Properties panel to change the host, 
port, and/or database name. For example:
•   For example, if the port and name were changed during installation (see 

Step 7: Select the Database Settings on page 22) to port 16524 and name 
host1_rdb, change the Data source address field to:
localhost:16524/host1_rdb

•   If the Resource Database was not created during installation, the host, 
port, and name of a running Resource Database should be entered:
host2:30000/host2_rdb

3 Select File > Save or right-click and select Save from the pop-up menu to save 
the changes.

4 If the Resource Database port has been changed, the port number entered 
above must be used when the database is subsequently launched. There are 
two options to set the port when the database is launched:
•   Edit the DB_TCP_PORT property in the environment.ccf configuration 

file. The DB_TCP_PORT property is used by the ea_admin, ea_ping, 
ea_start, ea_status, ea_shutdown and ea_shutsrvr commands to determine 
which TCP port the Resource Database server uses for accepting requests.

Edit the environment.ccf file to change the value of the DB_TCP_PORT 
property: The environment.ccf file is located in the <JI_install_dir>/config 
directory, where <JI_install_dir> represents the installation directory (and 
drive letter, if appropriate) where webMethods JI system software was 
installed.

DB_TCP_PORT=16524

•   Edit the database start, ping and shutdown command scripts. 
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•   Edit the db_ping.bat, db_shutdown.bat and db_start.bat (Windows) or 
db_ping.sh, db_shutdown, and db_start.sh (UNIX) files to change the default 
port number. To do this, open each of the files in a text editor such as vi or 
Notepad. The files are located in the <JI_install_dir>/bin directory, where 
<JI_install_dir> represents the installation directory (and drive letter, if 
appropriate) where webMethods JI system software was installed. 

UNIX:

To change the port number used by the db_ping.sh script, change the 
following lines:

db_pass=""
db_port="30000"
debug=FALSE

to:

db_pass=""
db_port="<db_port>"
debug=FALSE

where <db_port> represents the new port number. The same process 
should be repeated for the remaining db_shutdown.sh and db_start.sh 
scripts.

Windows:

To change the port number used by the db_ping.bat script, change the 
following lines:

SET DB_HOST=""
SET DB_PORT=""
SET DB_USER=""

to:

SET DB_HOST=""
SET DB_PORT="<db_port>"

Note: This option applies only if you have set the DB_START_CMD, 
DB_PING_CMD and DB_SHUTDOWN_CMD properties in the 
environment.ccf configuration file and that you have not replaced or 
otherwise modified the db_ping, db_shutdown and db_start script distributed 
with webMethods JI.
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SET DB_USER=""

where <db_port> represents the new port number.
•   Pass the port onthe command line. The port can be passed on the 

command line when the database is launched. The command line option 
used depends on the command used to launch the database; for example, 
when launching the databas with the ea_start command, the -Q or 
--dbPort command line options:

UNIX:

cd <JI_install_dir>/bin
./ea_start -D -Q <db_port>

Windows:

cd <JI_install_dir>\bin
.\ea_start -D -Q <db_port>

Where <JI_install_dir> represents the directory in which 
webMethods JI is installed and <db_port> represents a valid port 
number for the Resource Database server. If Windows shortcuts are used 
to launch the Resource Database server, you will need to edit the shortcut 
to pass the port number at the command line. For information about 
editing shortcuts, see your Windows documentation.

Step 5: Starting the Environment Manager

The Environment Manager is a process that runs on an webMethods JI server, 
providing a central management and control point for webMethods JI server-side 
processing. For more information about the Environment Manager, see the 
webMethods JI User’s Guide. Both the Resource Database and the Resource Server 
must be running prior to starting the Environment Manager.

The Environment Manager is started using the following command:

UNIX:
cd <JI_install_dir>/bin

./ea_start -e

Windows:
cd <JI_install_dir>\bin

.\ea_start -e
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The Environment Manager can also be launched using shortcuts in Windows, if 
shortcuts were created during installation. For example, if shortcuts were added 
to the Start Menu during installation, the Environment Manager can be started by 
selecting the Environment Manager shortcut from the appropriate program 
menu in the Start Menu.

Step 6: Connecting to the Environment Manager in the 
Configuration Manager

In this step, we will use the Configuration Manager to connect to the 
Environment Manager and verify that all the server components are running.

1 In the Configuration Manager, highlight the Environment Managers node. 
Select File > Auto Find, or click on the Auto Find button  to locate the 
Environment Manager.

2 After the Environment Manager has been located, it will be listed by its 
hostname and ports (both the listening port and RMI port are listed). 
Highlight the Environment Manager and select File > Connect or click the 
Connect button  to connect to the Environment Manager (Figure 35).

Note: If the Environment Manager does not start, it could be due to a port 
conflict. By default, the Environment Manager tries to start using a listening 
port of 30001, and an RMI port of 30002 (it can share this RMI port with the 
Resource Server). To change the port values, use the -p <serverport> and 
-d <rmiport> command line options when launching the Environment 
Manager:

cd <JI_install_dir>/bin
./ea_start -e -p <serverport> -d <rmiport>

Where <serverport> represents a valid port number for the Environment 
Manager’s listening port and <rmiport> represents a valid port number of the 
Environment Managers’s RMI port (this port can be the same as the Resource 
Server’s RMI port).
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Figure 35.  List of host names and ports

When you have successfully connected to the Environment Manager, you 
have verified that the three required server components are running:
•   The Environment Manager.
•   The Resource Server serving the Resource Database and other resources 

requested by the Environment Manager.
•   The Resource Database requested by the Environment Manager.

At this point, if default settings are used for all remaining configurable items, 
installation and configuration is complete. Proceed to Step 11: Setting EA_ENV and 
Editing the environment.ccf File on page 70.

Step 7: Editing Environment Manager Configuration 
Parameters

With the Environment Manager highlighted, change the following information in 
the Properties panel for the Environment Manager:

• Java Virtual Machine (JVM) location: If the default JVM provided during 
installation is installed, this parameter does not need to be edited. 

• Environment Manager configuration name: Environment Manager 
configurations are located in the Resource Database and are used to store load 
balancing parameters, service details, and other information related to the 
Environment Manager. Environment Managers then “subscribe” to a 
configuration contained in a Resource Database by setting this parameter to 

Note: If you wish to change the JVM selection after the installation, the 
correct path and filename of the JVM should be entered here. 
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the name of the corresponding configuration in the Resource Database. See the 
webMethods JI User’s Guide for more information about Environment Manager 
configurations.
The name entered here must correspond to an Environment Manager 
configuration name entered in the Resource Database. See Step 10: Editing the 
Environment Manager Configuration in the Resource Database.

• Configuration resource name: This parameter represents the name of the 
Resource Database that the Environment Manager will request. When the 
Environment Manager is launched, it sends out a multicasting request for the 
Resource Database using this name. The first Resource Server that serves a 
resource of this name will respond to the Environment Manager’s request, 
and the Environment Manager and Resource Server will communicate. As a 
result, each Resource Database should have a unique Configuration resource 
name to guarantee that the correct Resource is served to the Environment 
Manager.

The name entered here must correspond to the name of a Resource served by 
a Resource Server running in your webMethods JI environment. For 
information about changing the default Resource name for the Resource 
Database, see Step 9: Changing the Resource Name for the Resource Database.

Step 8: Changing the Resource Server’s RMI Port

Remote Method Invocation (RMI) ports are used by Resource Servers and 
Environment Managers to allow these server components to interact. Both the 
Resource Server and Environment Manager must have an RMI port; if they are 
both running on the same machine they can share the same port. However, if the 
same RMI port is used for the Environment Manager and the Resource Server 
and the Resource Server goes down, the Environment Manager must then be 
restarted.

Running the Environment Manager and Resource Server on different RMI ports 
provides a slightly better fault tolerance, however, this requires an alternate 
usage of the ea_shutdown command. For this situation, the ea_shutdown command 
must be separately invoked using the “-e -p <RMI port>” options.

To change the Resource Server’s RMI port, highlight the Resource Server in the 
Configuration Manager Tree and enter the new port for the RMI port number 
parameter (you must be connected to the Resource Server before you can view or 
edit its parameters. See Figure 36).
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Figure 36.  Change the resource server’s RMI port

Step 9: Changing the Resource Name for the Resource Database

If the Configuration resource name parameter for the Environment Manager was 
changed above, the Resource name of the Resource Database should be changed 
to the new name. Highlight the Resource name, subordinate to the Resource 
Server in the Configuration Manager tree and select Edit > Rename or right-click 
and select Rename from the pop-up menu. Enter the Resource name as it was 
entered in the Environment Manager’s Configuration resource name parameter 
(Figure 37).

Figure 37.  Change the resource name for the resource database
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Step 10: Editing the Environment Manager Configuration in the 
Resource Database

The Resource Database contains configuration information related to 
Environment Managers listed in the Environment Manager Configuration node. 
Environment Managers then “subscribe” to a configuration contained in their 
Resource Database by setting their Environment Manager configuration name 
parameter (see Step 7: Editing Environment Manager Configuration Parameters, 
above). 

The following items related to the Environment Manager configuration should be 
changed:

•   The name of the configuration. The default name for the database’s 
Environment Manager configuration is eaconfig. This should be 
changed to the name entered above for the Environment Manager 
configuration name parameter.

•   The Environment Manager’s listening port and RMI ports should be 
changed to the appropriate port numbers.

In addition, you may want to change configuration parameters, such as load 
balancing information, for Environment Managers. See the webMethods JI 
User’s Guide for further information.

3 Opening the database. To edit the database’s Environment Manager 
configuration, open the database by highlighting the database and selecting 
File > Open or clicking on the Open button ( ). This will open a new node 
in the Tree view, named Resources. 
One of the subordinate nodes under Resources will be Environment Manager 
Configurations (Figure 38).
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Figure 38.  Opening the database

4 Expand the Environment Manager Configuration node by clicking on the “+” 
next to the node. The default configuration, eaconfig, will be listed as a 
subordinate node.

5 Highlight the eaconfig configuration. 
A number of parameters are displayed in the Properties panel of the 
Configuration Manager (Figure 39).

Figure 39.  Properties in the Configuration Manager
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6 To change the name of the Environment Manager configuration, select Edit > 
Rename or right-click and select Rename from the pop-up menu. Enter the 
name of the configuration. This name must correspond to the Environment 
Manager Configuration name parameter for all Environment Managers that 
will subscribe to this configuration (see Step 7: Editing Environment Manager 
Configuration Parameters, above).

7 Next, change the following parameters:
•   Load balancing group name. This parameter is used for load balancing 

purposes. To balance load among multiple Environment Managers, the 
Load balancing group name should be the same for all configurations to 
which the Environment Managers subscribe. For more information about 
load balancing, see the webMethods JI User’s Guide.

•   Port number for incoming client connections. Enter the correct port 
number for the Environment Manager’s listening port.

•   RMI port number. Enter the correct port number for the Environment 
Manager’s RMI port. If both the Resource Server and Environment 
Manager are both running on the same machine, they can share the same 
RMI port.

Additional Environment Manager configuration parameters govern service 
behavior and load balancing algorithms. For more information, see the 
webMethods JI User’s Guide.

Step 11: Setting EA_ENV and Editing the environment.ccf File

This final step should be performed in order to use the ea_start, ea_shutdown, 
ea_status, and other administrative commands. These commands require that the 
EA_ENV environment variable be set, as well as four parameters in the 
environment.ccf configuration file.

1 Set the EA_ENV environment variable to the configuration directory of your 
webMethods JI installation.
UNIX (borne and korn shells):
set EA_ENV=<JI_install_dir>/config

export EA_ENV

UNIX (C shell):
setenv EA_ENV=<JI_install_dir>/config

Windows:
set EA_ENV=<JI_install_dir>\config

Where <JI_install_dir> represents the installation directory (and drive 
letter, if appropriate) of your webMethods JI installation.

2 Edit the environment.ccf configuration file. This file is located in 
<JI_install_dir>\config. Set the following parameters:
•   EA_HOME. Represents the directory location of webMethods JI 

installation.
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•   DB_TCP_PORT. Port number of Resource Database server.
•   EA_ENVMGR. The host name or IP address and port number of the 

Environment Manager.

Shutting Down the Environment

After changing the ports and other information, your environment should be 
restarted to make sure the changes take effect. To shut down your environment, 
follow these directions:

To shut down the environment, enter the following at the command prompt:

UNIX: 
cd <JI_install_dir>/bin

./ea_shutdown

Windows: 

Note: These parameters can be set as environment variables rather than 
using the environment.ccf file.
webMethods JI Installation and Configuration Guide Version 4.5 71



Chapter 2. Configuring the Environment

 

72 webMethods JI Installation and Configuration Guide Version 4.5



 

Chapter 3.  Installing and Configuring webMethods JI 
Clients

About webMethods JI Clients

The following client libraries and interfaces are available with webMethods JI. 
For more information about the webMethods JI client libraries and supported 
platforms, see the webMethods JI Client Developer’s Guide.

webMethods JI Client Libraries and Interfaces

The following client libraries and interfaces are available with webMethods JI:

• The Java Client Library Version 3 (JClient3): JClient3 is a simplified client 
library written in Java. It is a set of Java packages that provide the functions 
required for clients developed in the Java programming language to interact 
with webMethods JI services. The JClient3 is available on all supported 
platforms and requires JDK 1.6 or newer. 

• Gateways: Several gateways are provided with webMethods JI.
•   XML Gateway: A servlet-based connector that enables integration with a 

client using XML messaging over HTTP.
•   SOAP Gateway: A servlet-based connector that enables clients to invoke 

webMethods JI services as Web Services using SOAP messaging over 
HTTP.

•   MQ Gateway: A standalone gateway that allows MQ enabled clients and 
MQ networks to invoke webMethods JI Services.

Installing webMethods JI Clients

webMethods JI clients are installed using the installation program, described in 
Chapter 1, "webMethods JI Installation". The client components can be installed 
with the server components, or can be installed separately by selecting the Full 
Client button in Step 10: Select the Installation Set (described on page 24). To install 
all the client components, select the Full Client button and click on the Install 

Note: For a list of supported platforms and other system requirements, 
please refer to the webMethods JI Release Notes.
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button. To install one or more individual client components, select the Customize 
button and select the appropriate clients from the next window (see Step 11: 
Customizing the Installation Set on page 26).
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Chapter 4.  Creating Databases

This chapter describes how to create Resource Databases using the ea_createdb 
command. During installation, the webMethods JI installation program can be 
used to create a Resource Database (see Step 7: Select the Database Settings on page 
22 in Chapter 1, "webMethods JI Installation"). However, there are some 
situations in which you choose not to create a Resource Database during 
installation, or where you may want to create additional databases.

Creating Databases Without Using the Installation 
Program

To create additional webMethods JI Resource Databases or to create a Resource 
Database without using the installation program, follow these directions:

Windows:

1 Start the Resource Database server. The database server can be started by 
selecting the ResourceDatabase shortcut, if shortcuts were created during 
installation, or at the command prompt by typing:
cd <JI_install_dir>\bin

.\ea_start -D

where <JI_install_dir> represents the drive letter and directory of the 
webMethods JI installation.

2 Execute the ea_createdb program. At the command prompt, type:
cd <JI_install_dir>\bin

.\ea_createdb -n <DBname> -p <port> -d <JI_install_dir>

where <DBname> is the name of the new database, <port> is the port name 
or number of the database daemon, and <JI_install_dir> represents the 
drive letter and directory of the webMethods JI installation.

For example:
.\ea_createdb -n access -p 30000 -d c:<JI_install_dir

will create a database named “access” using the Resource Database server 
running on port 30000. The database will be created in the directory that the 
database server is using as its database directory. By default, this directory is 
<JI_install_dir>\databases, but this default directory can be overridden using 
the -a <path> command line option to the ea_start command when the 
Resource Database server is started.
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UNIX:

1 Start the Resource Database server at the command prompt by typing:
cd <JI_install_dir>/bin

./ea_start -D

where <JI_install_dir> represents the directory of the webMethods JI 
installation.

2 Execute the ea_createdb program. At the command prompt, type:
cd <JI_install_dir>/bin 

./ea_createdb -H <host> -n <DBname> -p <port> -d <JI_install_dir>

where <host> is the host name of the host machine (the default is 
localhost), <DBname> is the name of the new database, <port> is the port 
name or number of the database daemon, and <JI_install_dir> 
represents the directory of the webMethods JI installation. For example:
./ea_createdb -n access -p 30000 -d /opt/<JI_install_dir>

will create a database named “access” using the Resource Database server 
running on the localhost, port 30000. The database will be created in the 
directory that the Resource Database server is using as its database directory. 
By default, this directory is <JI_install_dir>/databases, but this default directory 
can be overridden using the -a <path> command line option to the ea_start 
command when the Resource Database server is started.

Upgrading Previous Versions of the Resource Database

Customers using previous versions of webMethods JI (Jacada Integrator) must 
export their current data using the provided utilities. This data must then be 
imported for use with the desired version of webMethods JI.

Exporting your Database from Jacada Integrator Version 3.5

The Jacada Integrator version 3.5 ea_exportdb utility can be used to export a 
Jacada Integrator 3.5 Resource Database, as might be needed to migrate a 3.5 
installation to a different machine. Please follow the instructions detailed in the 
previous section.

Importing your Database

In order to import your Jacada Integrator database file, the webMethods JI 
Resource Database server must be running. To start the database server from the 
command prompt, type:
<JI_install_dir>/bin/ea_start -D
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Where <JI_install_dir> represents the directory (and drive letter, if applicable) 
where the webMethods JI software was installed.

When the Resource Database server is running, import the EDF file created 
above. Use the webMethods JI ea_importdb command to import the Resource 
Database export file created by the ea_exportdb utility. It is recommended that 
the import utility be run from the bin directory of the webMethods JI 
installation. 

For example:

UNIX:
cd <JI_install_dir>/bin

./ea_importdb <filename>

Windows:
cd cd <JI_install_dir>/bin

.\ea_importdb <filename>

Where <JI_install_dir> represents the directory (and drive letter, if applicable) 
where the webMethods JI software is installed and <filename> is a valid export file 
name, such as myea31db.exp or myea35db.exp.

Exporting a Resource Database from Jacada Integrator 
Versions 2.x

To export your Jacada Integrator version 2.6 or 2.7 Resource Database 
information, use the ea_rdbexport utility found in the bin directory of your 
Jacada Integrator version 2.6 or 2.7 installation. 

For example:

<Version 2.x EA_HOME>/bin/ea_rdbexport <filename>

Where <Version 2.x EA_HOME> is the directory of your Jacada Integrator version 
2.6 or 2.7 installation and <filename> is a valid file name, such as myea2xdb.edf.

Importing your Jacada Integrator Version 2.x Export File

In order to import your Jacada Integrator version 2.x Resource Database export 
file into webMethods JI current version, the current version’s Resource Database 
server must be running. Use the webMethods JI ea_rdbimport utility to import 
the Resource Database export file created by the ea_rdbexport utility. For 
example:
cd <JI_install_dir>/bin

Note: Jacada Integrator versions 2.6 and 2.7 were available on UNIX only.
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./ea_rdbimport <filename>

Where <JI_install_dir> represents the directory where the webMethods JI 
software is installed and <filename> is a valid export file name, such as 
myea2xdb.edf.
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Chapter 5.  Uninstalling webMethods JI Software

The webMethods JI installation program creates an uninstall program to simplify 
removal of webMethods JI software. The uninstall program will remove 
everything that was installed into the webMethods JI installation directory, 
except for configuration information such as files in the <JI_install_dir>/config 
directory, and database files in the <JI_install_dir>/databases directory. 
Additionally, any files that are created in the <JI_install_dir> hierarchy after 
installation will cause the parent directory structure and the new files themselves 
to not be removed by the uninstaller.

This means that any changes to batch files, scripts, and .lax files will not be saved 
when the webMethods JI software is uninstalled. If you intend to reinstall 
webMethods JI and wish to use these files, you should back up any changed files 
and databases prior to uninstalling the webMethods JI software.

Uninstall

Follow these directions to uninstall the webMethods JI software:

Windows:

1 Select Start Menu > Settings > Control Panel to open the Windows Control 
Panel.

2 Double-click on the Add/Remove Programs icon in the Control Panel. This 
will open the Add/Remove Programs applet.

3 Highlight the webMethods JI entry in the list box and select the Add/Remove 
button to remove the webMethods JI software.

UNIX:

1 At the command prompt, change to the 
<JI_install_dir>/UninstallerData<ji_version> directory, where <ji_version> 
represents the version number of your webMethods JI installation.

2 Enter the following command:
./Uninstall

This will remove the webMethods JI software.

An additional file, mapmaker40.cfg, is created the first time MapMaker is started 
by each user. This file contains configuration information related to MapMaker 
and is not editable. This file is not removed by the uninstall program, and by 
default, is located in the root of the user’s home directory.
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Glossary

ACL Access Control List 

Actions Used by webMethods JI Java services to navigate from one 
legacy screen to the next on the legacy application. An action 
includes all data that was input by the user during trail 
recording in MapMaker, along with the AID key or Action that 
caused the screen transition.

Action Key A key sequence that performs an action in the legacy 
application. Action keys are valid for the Telnet protocol and 
are similar in concept to AID keys. 

Applet A program written in the Java programming language that is 
accessed from a Web browser.

Application A Java program run as a stand-alone program.

API API - Application Programming Interface. The library of C or 
Java functions callable from UNIX and Windows programs. 
Used to develop webMethods JI clients and services.

AID Key The Attention Identifier Key (AID). A single key on the 
keyboard that, when pressed by the user, performs an action in 
the legacy application. Typical AID keys include the Enter and 
PF keys, although the legacy application may change their 
usage or use other AID keys. AID keys are valid for the TN3270 
and TN5250 protocols.

Browser A program that allows users to access information on a Web 
server. Also known as a Web browser.

CGI Common Gateway Interface. A standard method for external 
gateway programs to interface with Web servers.
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Character 
Encoding

The format or encoding of a language-set character. Character 
encodings are usually 1, 2, 3, or 4 bytes. Unicode is an example 
of a 2-byte character encoding. Other examples are ASCII, 
EBCDIC, and UTF-8.

Character Mode Character mode describes the functionality in webMethods JI 
that communicates with character-based applications over the 
Telnet protocol.

Client In webMethods JI, client refers to one of two items: 

• A Runtime version of an application developed in Java 
that uses webMethods JI client APIs to communicate with 
webMethods JI services. 

• Also refers to a third-party software application that 
interfaces with webMethods JI services and functions 
similarly to an application developed with a 
webMethods JI client API.

Client Functions The C or Java functions used to allow clients to connect to services, 
execute service methods, and input and extract data.

Content Pane A content pane, also called a panel, is a GUI component that 
acts as a container for various GUI components. A content pane 
is basically a window that other GUI objects, such as buttons 
and text fields, are placed on.

Cookie A general mechanism used by Web servers to both store and 
retrieve information on the client side of the connection.

Custom Classes Classes that are used to “extend” or customize service code 
that was generated in MapMaker.

Data Field A data field is an individual field on the legacy screen that is 
added to either a data template or a table template. Data fields 
are used in conjunction with output variables to extract data 
from the legacy screen.

Data Mapping Refers to the mapping of data in the flow of a method. Every 
point in a method where data is sent to or retrieved from an 
external source requires data mapping. Data mapping is 
defined in the Data Mapping Editor. 
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Data Stream The flow, or stream, of information between computer 
programs. Data on the data stream is represented using 
“character encoding” and is transferred using a mutually 
agreed upon protocol.

Data Template A data template is a logical representation of non-repeating 
data fields on the legacy screen. Data templates are defined in 
MapMaker and are used in conjunction with output variables 
to extract data from the legacy application. Similar to table 
template, used to define repeating data fields.

Data Typing Refers to the creation and definition of data types. Data types 
are defined and maintained in MapMaker’s Business Entity 
Editor.

DBCS Double-Byte Character Set.

DLL Dynamically Linked Library. A library of function calls used in 
Windows environments.

DOM Document Object Model (aka “random access” protocol for 
XML) – an XML parser that converts the XML document into a 
collection of objects, which can then be manipulated in any 
way you choose.

DTD Document Type Definition for XML – an optional part of the 
XML document prolog that specifies the kinds of tags that can 
be included in an XML document and the valid arrangement of 
those tags.

EAServiceBean The interface between webMethods JI Java service code and the 
JService that manages the service in the webMethods JI server 
environment. The EAServiceBean can be extended or 
customized to change the interface if required.

ECS Extended Character Support.
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EIS Enterprise Information System - an application providing 
information of critical importance to the day-to-day planning 
and/or operation of a business. EISs are generally run on larger 
platforms, such as mainframes or minicomputers. EISs provide 
the information infrastructure for an enterprise. Examples of 
EISs include enterprise resource planning systems, mainframe 
transaction processing systems, relational database 
management systems, and other legacy information systems. 

Enterprise System A system involved in an organization’s critical business 
processes. Typically, enterprise systems are large and complex, 
use database management systems (DBMSs), and run on 
mainframes or minicomputers.

Formatted Fields Fields on the legacy application that have special formatting 
characteristics. MapMaker identifies all such fields on the 
legacy screen and uses the field layout to match screens (unless 
the fields are disabled and Tags are used to identify screens).

GBBasic A Java package, com.jacada.mapstudio.GBBasic, that is included 
with webMethods JI and can be used to extend or customize 
Java service code that was generated in MapMaker.

GUI Graphical User Interface. An application that allows users to 
interface with computer programs in a graphical environment. 
In webMethods JI, MapMaker, the Configuration Manager, 
and the System Monitor are all Graphical User Interfaces.

HTML HyperText Markup Language, a format used to create Web 
documents.

Hos tA computer machine where applications reside. In 
webMethods JI, hosts can be the machine on which 
components of the webMethods JI environment are running, 
the machine on which the telnet, TN3270, or TN5250 server 
reside, or the machine on which the legacy applications reside.

IBE Internal Business Entity. Refers to data types that are used 
internally by the webMethods JI Service. A global variable may 
be defined of an IBE data type. 

IDE Integrated Development Environment. Refers to a graphical 
development tool that uses standard GUI components to 
facilitate application development.
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Jacada Integrator See webMethods JI. 

Java An object-oriented, platform-independent programming 
language developed by Oracle.

Java services webMethods JI services developed using the Java 
programming language. Java services are generated from the 
MapMaker graphical development interface (GUI) and can be 
customized using the custom service classes included with 
webMethods JI.

JClient3 The Java Client Library version 3 is an improved version of the 
JClient, which allows webMethods JI clients to be developed 
using JDK 1.6 or newer.

JDBC Java DataBase Connectivity. 

JDK Java Development Kit. The development environment for the 
Java programming language. Includes a Java Runtime 
Environment.

JRE Java Runtime Environment. The minimum environment 
required to run Java applications. This is a combination of a 
JVM along with the core classes and files required to run Java 
applications.

JVM Java Virtual Machine. A Java interpreter that converts Java 
code into executable code.

Legacy data Data residing on a mainframe platform.

Legacy host The machine or host on which legacy applications reside.

Map The logical representation of the screens, fields, data input and 
AID keys that make up the user interaction with a legacy 
application. Maps are created in MapMaker. Note that 
webMethods JI’s use of the term Map is distinct from the 
java.util.Map that is included with Java.
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MapMaker The graphical development interface provided with 
webMethods JI for the purpose of developing Java services. 
Used to record trails, maps, data and table templates, create 
methods and services, and then generate and optionally 
deploy the services into the webMethods JI server 
environment.

Methods Object-oriented entity of one or more functions. A collection of 
methods, initialization code, and events make up a service.

MLM Map-List-Map. Refers to an XBE data type used for 
communication with a client, such as a Java, C, or VB Client.

Multicasting A connectionless IP networking communication in which 
applications on the IP network broadcast information over a 
well-known socket.

Multithread-safe See thread-safe.

Multithreaded See threaded.

Offset Refers to the location of data on the legacy screen. The offset is 
determined using the following format: For an 80 column 
screen, the offset is (column # - 1) + 80 x (row # -1). For example, 
the first column of the second row is position 80: 
(1 - 1) + 80 x (2-1).

Package A collection of java classes that are grouped together to form a 
logical combination of classes.

Presentation Space A representation of the communications between the legacy 
host to the webMethods JI environment, including the screen 
and field information from the legacy application. 

Protocol Agent A software interface that governs the procedures used to 
exchange information between physically remote entities such 
as computer systems.The Protocol Agent governs the format of 
the messages, the generation of checking information, and the 
flow control, as well as the actions to take in the event of errors.

Proxy Server Special instances of Resource Servers that allow multicasting 
communication to take place over multiple sub-nets.
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Resources The components of webMethods JI that are managed by the 
Resource Server. These components include Resource 
Databases and license files.

Resource Database A database that is used in the webMethods JI environment to 
store environment and service configuration, along with 
service code and maps. 

Resource Serve rManages the communication between environment managers 
and the webMethods JI resources.

RMI Remote Method Invocation. A standard from Oracle that 
allows distributed Java objects to communicate with each other 
over TCP/IP networks.

Screen  The screen, as contained in the data stream, that is coming 
from the legacy host. 

Screen Mapping The process of marking the physical boundaries of, and 
defining the screen components found on, an external 
application screen. The components include tags, fields, areas, 
repeating areas, and repeating fields. 

Service A collection of methods which answer requests from a client. 

SOCKS SOCKS is a firewall proxy protocol.

System Monitor The tool used to monitor the webMethods JI System. It allows 
you to monitor, log, and view real-time activity for all or 
selected Environment Managers, JClusters and JServices, 
clients, and services. 

Table Template A Table Template is a logical representation of the area on a 
legacy screen that contains repeating Data Fields. Table 
templates are defined in MapMaker and are used in 
conjunction with output variables to extract data from the 
legacy application. Similar to Data Template, used to define 
non-repeating Data Fields.

Tag A user-defined component of the host application screen that 
most often serves as a label for fields. You can define any static 
screen text as a tag. MapMaker can identify external 
application screens by the tags that are defined for them.
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Telnet A TCP/IP-based terminal emulation protocol. Requires a Telnet 
server. Telnet is also used to describe the Character Mode 
functionality within webMethods JI.

Terminfo UNIX terminal information database. See the UNIX 
terminfo(4) man page.

Thread-safe Also multithread-safe (MT-safe). A description of a function or 
library that may be called in a threaded environment without 
any additional coding.

Thread A single flow of control within a process or address space. 
Programs using two or more threads are referred to as 
threaded or multi-threaded.

Threaded Also multithreaded. A form of multi-tasking that uses multiple 
independent execution threads.

TN3270 An implementation of the telnet protocol that is used to 
communicate between TCP/IP networks and IBM mainframe 
applications that use IBM 3270 terminals. A TN3270 server is 
required for connection from the TCP/IP network to the 
mainframe.

TN5250 An implementation of the telnet protocol that is used to 
communicate between TCP/IP networks and IBM AS400 
applications that use IBM 5250 terminals. A TN5250 server is 
required for connection from the TCP/IP network to the AS400.

Trail The linear path of all screens encountered during navigation 
through a host application. MapMaker records trails during 
host application interaction.

Unicode  A universal character code.

Web A network of computers based on the client-server model. The 
Web uses Web browsers to access information from a Web 
server. A Web can be a part of the World Wide Web or can be a 
part of a separate network, also know as an “Intranet”. 

Web browser A program that allows users to access information on a Web 
server.
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webMethods JI Consists of one or more Environment Managers, Resource 
Servers, resources including the Resource Database, and 
webMethods JI clients and services.

XBE eXternal Business Entity. Refers to data types that are used for 
the webMethods JI Service to send and receive data to and 
from an external source. Such external sources are Legacy 
Screens and Clients. 

XML eXtensible Markup Language – a text-based markup language 
that is fast becoming the standard for data interchange on the 
web.

XSD XML Schema Definition. Specifies how to formally describe the 
elements in an XML document. One of the XBE data types 
supported by MapMaker is XML/XSD.
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